# Content

1. **Document History** .......................................................... 4
2. **Getting Started** ............................................................... 5
   2.1 Introduction ................................................................. 5
   2.2 Global Definitions ......................................................... 5
   2.3 Important SAP Notes .......................................................... 6
3. **Technical System Landscape** ........................................... 8
   3.1 Scenario/Component Matrix ............................................... 8
       Introduction ................................................................ 8
       SAP NetWeaver 7.5 ......................................................... 9
       SAP SCM Optimizer ......................................................... 9
       SAP Internet Graphics Service .......................................... 9
   3.2 Related Documentation .................................................... 9
4. **Monitoring of SAP Transportation Management** ............ 11
   4.1 Introduction ................................................................. 11
   4.2 Alert Monitoring with CCMS ........................................... 11
       Introduction ................................................................ 11
       CCMS Monitoring Installation and Setup .......................... 11
       Component-Specific Alert Monitoring ............................... 12
   4.3 Detailed Monitoring and Tools for Problem and Performance Analysis ........................................... 13
       Introduction ................................................................ 13
       SAP Transportation Management 9.4 Analysis Tools ........... 13
       SAP SCM Optimizer Analysis Tools ................................. 15
       SAP Business Information Warehouse .............................. 17
       Transportation and Logistics Collaboration Portal Analysis Tools ........................................... 17
   4.4 Data Consistency ............................................................. 19
5. **Management of SAP Technology** .................................... 22
   5.1 Introduction ................................................................. 22
   5.2 Starting and Stopping ....................................................... 22
   5.3 Software Configuration ................................................... 24
   5.4 Administration Tools ...................................................... 25
       Introduction ................................................................ 25
       Administration Tools for SAP Transportation Management 9.5 ........................................... 25
       Administration Tools for SAP SCM Optimizer ........................ 25
       Administration Tools for SAP Business Information Warehouse ........................................... 26
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.5</td>
<td>Backup and Restore</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>SAP TM Server / SAP SCM Optimizer</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>SAP Internet Graphics Server</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>SAP XI Server</td>
<td>29</td>
</tr>
<tr>
<td>5.6</td>
<td>Periodic Tasks</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Scheduled Periodic Tasks</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Required Manual Periodic Tasks</td>
<td>32</td>
</tr>
<tr>
<td>5.7</td>
<td>Load Balancing</td>
<td>32</td>
</tr>
<tr>
<td>5.8</td>
<td>Trigger Processing</td>
<td>32</td>
</tr>
<tr>
<td>5.9</td>
<td>Management of Outdated Technical Data</td>
<td>33</td>
</tr>
<tr>
<td>5.10</td>
<td>Scenario Administration Concept</td>
<td>33</td>
</tr>
<tr>
<td>6</td>
<td>High Availability</td>
<td>35</td>
</tr>
<tr>
<td>6.1</td>
<td>Introduction</td>
<td>35</td>
</tr>
<tr>
<td>6.2</td>
<td>SAP SCM Optimizer</td>
<td>35</td>
</tr>
<tr>
<td>7</td>
<td>Software Change Management</td>
<td>36</td>
</tr>
<tr>
<td>7.1</td>
<td>Introduction</td>
<td>36</td>
</tr>
<tr>
<td>7.2</td>
<td>Transport and Change Management</td>
<td>36</td>
</tr>
<tr>
<td>7.3</td>
<td>Development Requests and Development Release Management</td>
<td>37</td>
</tr>
<tr>
<td>7.4</td>
<td>Template Management</td>
<td>37</td>
</tr>
<tr>
<td>7.5</td>
<td>Support Packages and Patch Implementation</td>
<td>37</td>
</tr>
<tr>
<td>8</td>
<td>Services for SAP Solutions</td>
<td>39</td>
</tr>
<tr>
<td>9</td>
<td>Troubleshooting</td>
<td>40</td>
</tr>
<tr>
<td>10</td>
<td>Support Desk Management</td>
<td>41</td>
</tr>
<tr>
<td>10.1</td>
<td>Introduction</td>
<td>41</td>
</tr>
<tr>
<td>10.2</td>
<td>Remote Support Setup</td>
<td>41</td>
</tr>
<tr>
<td>10.3</td>
<td>Problem Message Handover</td>
<td>41</td>
</tr>
<tr>
<td>A</td>
<td>Appendix</td>
<td>42</td>
</tr>
<tr>
<td>A.1</td>
<td>Categories of System Components for Backup and Restore</td>
<td>42</td>
</tr>
<tr>
<td>A.2</td>
<td>Related Guides</td>
<td>44</td>
</tr>
<tr>
<td>A.3</td>
<td>Related Information</td>
<td>44</td>
</tr>
</tbody>
</table>
1 Document History

⚠️ Caution
Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at the following location: http://help.sap.com/tm.

The following table provides an overview of the most important document changes.

Table 1:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>2017-11-30</td>
<td>Initial Version</td>
</tr>
<tr>
<td>1.1</td>
<td>2017-12-21</td>
<td>Content changes to the guide</td>
</tr>
</tbody>
</table>
2 Getting Started

2.1 Introduction

Caution

This guide does not replace the daily operations handbook that we recommend customers create for their specific production operations.

Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never been more vital for your business success than now.

This guide provides a starting point for managing your SAP applications and maintaining and running them optimally. It contains specific information for various tasks and lists the tools that you can use to implement them. This guide also provides references to the documentation required for these tasks, so you need other guides such as the Master Guide, Technical Infrastructure Guide, and SAP Library.

Note

For more information about the various tasks that you can carry out and tools that you can use for SAP Event Management, see the Application Operations Guide for SAP Event Management on SAP Service Marketplace at http://help.sap.com/tm.

2.2 Global Definitions

SAP Application:

An SAP application is an SAP software solution that serves a specific business area such as ERP, CRM, PLM, SRM, or SCM.

Business Scenario:

From a microeconomic perspective, a business scenario is a cycle that consists of several different interconnected logical processes in time. Typically, a business scenario includes several company departments and involves other business partners. From a technical point of view, a business scenario needs at least one SAP application (for example, SAP ERP or SAP SCM) for each cycle and possibly other third-party systems. A business scenario is a unit that can be implemented separately and reflects the customer’s prospective course of business.
Component:

A component is the smallest individual unit considered within the Solution Development Lifecycle; components are separately produced, delivered, installed, and maintained.

2.3 Important SAP Notes

👉 Recommendation

Check regularly for updates to the Application Operations Guide.

Table 2: Important SAP Notes — Installation/Upgrade Notes

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1678998</td>
<td>Release Strategy for the ABAP Add-On SAPTM</td>
<td>None</td>
</tr>
<tr>
<td>2562832</td>
<td>Release Restrictions of SAP Transportation Management 9.5</td>
<td>None</td>
</tr>
<tr>
<td>2512482</td>
<td>Installation/Delta Upgrade note for TM 9.5</td>
<td>None</td>
</tr>
<tr>
<td>1539802</td>
<td>SAPTM: Overview note</td>
<td>None</td>
</tr>
<tr>
<td>2316985</td>
<td>Implementing the SCM Optimizer Version 13.0</td>
<td>None</td>
</tr>
<tr>
<td>2118104</td>
<td>Support Packages for SCEMSRV 920</td>
<td>None</td>
</tr>
<tr>
<td>1224284</td>
<td>Enterprise Services, Installing and Accessing the SOA Documentation. This SAP Note lists the business-related grouping of Enterprise Services.</td>
<td>None</td>
</tr>
<tr>
<td>1515223</td>
<td>SAP NetWeaver Process Integration: Release Recommendation. This SAP Note sets out our recommendation on which release of SAP NetWeaver PI you should use.</td>
<td>None</td>
</tr>
<tr>
<td>1529649</td>
<td>Factory Calendar Expires 2010</td>
<td>None</td>
</tr>
<tr>
<td>1388258</td>
<td>Version Interoperability within the SAP Business Suite</td>
<td>None</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Comment</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>1573180</td>
<td>AEX Enablement for SAP Business Suite</td>
<td>None</td>
</tr>
<tr>
<td>1846034</td>
<td>SAP Visual Business 2.1: Information about patches</td>
<td>None</td>
</tr>
<tr>
<td>1738013</td>
<td>TM: Integration with ERP Enhancement</td>
<td>None</td>
</tr>
</tbody>
</table>

Table 3: Important SAP Notes — Information/Consulting Notes

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000000</td>
<td>NetWeaver Business Client – FAQ</td>
<td>None</td>
</tr>
</tbody>
</table>

Table 4: Important SAP Notes — Troubleshooting Notes

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>423184</td>
<td>ALE: Problems with Logical System Names</td>
<td>None</td>
</tr>
<tr>
<td>1080668</td>
<td>Problems with alert subscription</td>
<td>None</td>
</tr>
<tr>
<td>1634677</td>
<td>TM: Checking Customizing settings in ERP</td>
<td>None</td>
</tr>
</tbody>
</table>
3 Technical System Landscape

3.1 Scenario/Component Matrix

3.1.1 Introduction

The following table lists the components that are available for each scenario:

Table 5:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>SAP TM</th>
<th>SAP ERP</th>
<th>SAP EM</th>
<th>SAP Optimizer</th>
<th>SAP VB</th>
<th>PI</th>
<th>T&amp;L Collaboration Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>International Inbound Logistics (IIL)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Domestic Outbound Transportation (DOT)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>O</td>
</tr>
<tr>
<td>LCL Ocean Freight (OF)</td>
<td>X</td>
<td>X</td>
<td>Not applicable</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Airfreight</td>
<td>X</td>
<td>X</td>
<td>Not applicable</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Intermodal Rail Freight</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Courier Express Parcel</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>O</td>
<td>X</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

Scenario component key: X = mandatory, O = optional, Not applicable = not part of the business process

3.1.2 SAP NetWeaver 7.5

SAP NetWeaver 7.5 is the integration and application platform for SAP TM 9.5. The following SAP NetWeaver components are part of the infrastructure:

- SAP Web Application Server (ABAP) 7.5
- SAP Web Application Server (Java) 7.5 (for printing purposes)
- SAP NetWeaver Exchange Infrastructure (XI) 7.5
- SAP NetWeaver BI (Business Intelligence) 7.5
- SAP NetWeaver Business Client 6.0
- SAP Gateway
- SAP UI5 Client Runtime

3.1.3 SAP SCM Optimizer

For information about installing and setting up SAP SCM Optimizer, see the Installation Guide for Windows or Linux. The guides are located on SAP Service Marketplace at https://service.sap.com/instguides

3.1.4 SAP Internet Graphics Service

The Internet Graphics Service (IGS) is part of SAP NetWeaver and can be used in SAP TM 9.4 to support the display of graphics and to integrate GIS data.

3.2 Related Documentation

The following table lists locations in which you can find more information about the technical system landscape.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Guide/Tool</th>
<th>Quick Link on SAP Service Marketplace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application-specific and industry-specific components such as SAP Financials and SAP Retail</td>
<td>Master Guide</td>
<td><a href="http://help.sap.com/tm">http://help.sap.com/tm</a></td>
</tr>
<tr>
<td>Technology components such as SAP Web Application Server</td>
<td>Master Guide</td>
<td><a href="http://help.sap.com/tm">http://help.sap.com/tm</a></td>
</tr>
<tr>
<td>Topic</td>
<td>Guide/Tool</td>
<td>Quick Link on SAP Service Marketplace</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------</td>
<td>---------------------------------------</td>
</tr>
</tbody>
</table>
4 Monitoring of SAP Transportation Management

4.1 Introduction

Within the management of SAP Technology, monitoring is an essential task. A section has therefore been devoted solely to this subject.

For more information about the underlying technology, see the SAP Library for SAP NetWeaver 7.5 at http://help.sap.com/nw75. In SAP Library, choose SAP NetWeaver Library: Function-Oriented View ➔ Application Server ➔ Application Server ABAP ➔ Monitoring and Administration Tools for Application Server ABAP or SAP NetWeaver Library: Function-Oriented View ➔ Application Server ➔ Application Server Java ➔ Administering Application Server Java ➔ Monitoring.

4.2 Alert Monitoring with CCMS

4.2.1 Introduction

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment. We provide you with the infrastructure and recommendations needed to set up your alert monitoring to recognize critical situations for SAP TM 9.5 as quickly as possible. SAP TM 9.5 uses the Computer Center Management System (CCMS) for alert monitoring.

4.2.2 CCMS Monitoring Installation and Setup

The Computer Center Management System (CCMS) provides a range of monitors for SAP environments and their components. These monitors are essential for understanding and evaluating the behavior of the SAP processing environment. In the case of poor performance values, the monitors provide you with the information required to fine tune your SAP system and therefore to ensure that your SAP installation is running efficiently.

For more information about installing and setting up the CCMS, see http://service.sap.com/instguides SAP NetWeaver.

To enable the auto-alert mechanism of CCMS, see SAP Note 617547.
4.2.3 Component-Specific Alert Monitoring

4.2.3.1 Introduction

The following components are part of SAP TM 9.5:

- SAP NetWeaver 7.5
- SAP Business Suite Foundation 7.48 (BS_FND 748)
- SAP SCM Basis 7.14 (SCM_BASIS 7.14)
- SAP Transportation Management 9.5 (SAP TM 9.5)
- SAP SCM Optimizer 13.0

4.2.3.2 SAP NetWeaver 7.5


4.2.3.3 SAP SCM Basis 7.0 Including Enhancement Package 4

SAP SCM Basis including enhancement package 4 enables monitoring of SAP Core Interface (CIF) and qRFC-related values such as an overview of blocked qRFCs. You can start the monitor from the user menu by choosing [SCM Basis ➤ Integration ➤ CCMS Monitor Sets](http://help.sap.com/library/) (transaction RZ20). For more information about setting up this monitor, see SAP Library for SAP Supply Chain Management on SAP Help Portal at [http://help.sap.com/scm](http://help.sap.com/scm). In SAP Library for [SAP Enhancement Package 4 for SAP SCM 7.0](http://help.sap.com/library/), choose [SCM Basis ➤ Alert Monitor](http://help.sap.com/library/).

4.2.3.4 SAP Transportation Management 9.5


4.2.3.5 SAP SCM Optimizer 13

For more information about installing and setting up SAP SCM Optimizer, see the Installation Guide for SAP SCM Optimizer. The guides are located on SAP Service Marketplace at [https://service.sap.com/instguides](https://service.sap.com/instguides).
4.2.3.6 Internet Graphics Service

The IGS can be monitored with CCMS, which provides an overview of the current IGS configuration, the port watchers available, and their associated interpreters. It also displays various performance values for the relevant IGS components.

To monitor IGS in the CCMS, you must activate CCMS Monitoring. You can do this by starting report GRAPHICS_IGS_ADMIN in transaction SE38. Enter IGS RFC-Destination and press F8. Then select the Environment menu and choose Switch on CCMS.

You can find the monitor tree for IGS in the CCMS (transaction R220) as the Internet Graphics Server in the monitor set SAP CCMS Monitors for Optional Components. For more information about the values displayed in the CCMS, see SAP Library for SAP NetWeaver at http://service.sap.com/installnw75. In SAP Library for SAP NetWeaver 7.5, choose SAP NetWeaver Library: Function-Oriented View ➤ Application Server ➤ Application Server ABAP ➤ UI Technologies in ABAP ➤ Further UI Technologies ➤ SAP Graphics ➤ Administering the Internet Graphics Service (IGS).

4.3 Detailed Monitoring and Tools for Problem and Performance Analysis

4.3.1 Introduction

SAP TM 9.5 is based on Web AS 7.5 (part of SAP NetWeaver 7.5).

For more information about technical problem analysis (such as with a database, the operating system, or workload analysis), see SAP Library for SAP NetWeaver at http://help.sap.com/nw75. In SAP Library for SAP NetWeaver 7.5, choose SAP NetWeaver ➤ Administration Information ➤ Technical Operations for SAP NetWeaver. This guide covers only the differences and additional information specific to SAP Transportation Management.

4.3.2 SAP Transportation Management 9.4 Analysis Tools

4.3.2.1 Trace and Log Files

Trace files and log files are essential for analyzing problems. The standard SAP NetWeaver tools such as transactions ST22 and SM21 can be used to monitor trace and log files. For more information, see SAP Library for SAP NetWeaver at http://help.sap.com/nw75. In SAP Library for SAP NetWeaver 7.5, choose SAP NetWeaver.
SAP TM 9.5 uses the application log (part of SAP NetWeaver) to store error, warning, and success messages issued in critical processes or in UI transactions. For UI transactions, the application log has to be saved explicitly by the user.


The following application logs can be monitored with transaction SLG1:

- /SCMTMS/TMS (Transportation Management)
- PPF (Post Processing Framework)

For a description of the tasks recommended for containing data growth, see Periodic Tasks [page 29].

### 4.3.2.2 Interface Monitors

Interface monitors are essential for analyzing problems with interfaces such as RFC, IDoc, and HTTP.

SAP TM 9.5 uses the standard tools available in the SAP Web Application Server 7.5, and does not require an application-specific tool. For more information, see the Technical Operations Manual for SAP NetWeaver.

SAP Transportation Management uses standard tools to monitor the XI interfaces. Use transaction SXI_MONITOR to monitor XI interfaces.

### 4.3.2.3 Workload Monitors

SAP Transportation Management uses the standard tools available in SAP Web Application Server 7.5 and does not require an application-specific tool. For more information, see SAP Library for SAP NetWeaver at http://help.sap.com/nw75. In SAP Library for SAP NetWeaver 7.5, choose SAP NetWeaver > Administration Information > Technical Operations for SAP NetWeaver.

### 4.3.2.4 Database Monitors

SAP Transportation Management uses the standard tools available in SAP Web Application Server 7.5 and does not require an application-specific tool.

4.3.2.5 Operating System Monitors

SAP Transportation Management uses the standard tools available for SAP Web Application Server 7.5 and does not require an application-specific tool.


For more information about the Operating System Collector (OS Collector), see SAP Library under the component Operating System Monitor.

4.3.3 SAP SCM Optimizer Analysis Tools

4.3.3.1 Introduction

Once SAP SCM Optimizer has been correctly installed and configured, the following monitors and transactions can be used for administration, analysis, and maintenance.

4.3.3.2 Administration Tools

Table 7:

<table>
<thead>
<tr>
<th>Monitoring Object</th>
<th>Monitor Transaction / Tool</th>
<th>Monitor Frequency</th>
<th>Indicator or Error</th>
<th>Monitoring Activity or Error Handling Procedure</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>User list for optimizers</td>
<td>rcc_session</td>
<td>As required</td>
<td>Not applicable</td>
<td>Displays a user list for optimizers</td>
<td>Basis Support</td>
</tr>
<tr>
<td>Versions of optimizers</td>
<td>rcc_version</td>
<td>As required</td>
<td>Not applicable</td>
<td>Displays optimizer versions</td>
<td>System monitoring team</td>
</tr>
<tr>
<td>Running optimizer processes</td>
<td>rcc_session</td>
<td>As required</td>
<td>Not applicable</td>
<td>Display optimizer processes</td>
<td>Basis Support</td>
</tr>
<tr>
<td>RFC destinations for optimizers</td>
<td>SM59 / rcc_cust</td>
<td>During installation or after configuration changes</td>
<td>Test connection status to ensure all is OK</td>
<td>Defining and checking optimizer RFC destinations – can also be used to check if optimizer server is online</td>
<td>System monitoring team and Basis Support</td>
</tr>
</tbody>
</table>
Monitoring Object | Monitor Transaction / Tool | Monitor Frequency | Indicator or Error | Monitoring Activity or Error Handling Procedure | Responsibility
---|---|---|---|---|---
Spool file of optimizer run | SM37 | As required | Messages in spool file | Check also for application errors after the optimizer run using rcc_log (see section Trace and Log Files [page 16]). | Application Support / Job scheduling team

4.3.3.3 Trace and Log Files

Trace files and log files are essential for analyzing problems.

Table 8: Important Trace and Log Files

<table>
<thead>
<tr>
<th>Monitoring Object</th>
<th>Monitor Transaction / Tool</th>
<th>Monitor Frequency</th>
<th>Indicator or Error</th>
<th>Monitoring Activity or Error Handling Procedure</th>
<th>Responsibility</th>
</tr>
</thead>
</table>
| Optimizer logs and trace files | rcc_log | Check frequently – daily, weekly | Check for Errors | Display and analyze optimizer logs and trace files. These files are on the server in the directory log of the SAP gateway on which the optimizers are installed (either own server or application, or database server): Directory (Windows version): 
\usr\sap\<SID>\G\GWNr\log or \usr\sap\<SID>\DVEBMGS\GWNr\log 
<SID> = SystemID 
<GWNr> = SystemNr (=GatewayNr) for example 00 For more information, see SAP Note 391808 | Basis Support |
<table>
<thead>
<tr>
<th>Monitoring Object</th>
<th>Monitor Transaction / Tool</th>
<th>Monitor Frequency</th>
<th>Indicator or Error</th>
<th>Monitoring Activity or Error Handling Procedure</th>
<th>Responsibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the detail level of trace files</td>
<td>/SCMIMS/WDC_TS_ENG_CONF</td>
<td>Check frequently ~ daily, weekly</td>
<td>Check for Errors</td>
<td>Monitoring Activity or Error Handling Procedure</td>
<td>Basis Support</td>
</tr>
<tr>
<td>Spool file of optimizer run</td>
<td>SM37</td>
<td>As required</td>
<td>Messages in spool file</td>
<td>Check also for application errors after the optimizer run using rcc_log (see above).</td>
<td>Application Support / Job scheduling team</td>
</tr>
</tbody>
</table>

### 4.3.4 SAP Business Information Warehouse

SAP Business Information Warehouse (SAP BW) is optional. User navigation data from interactive scripting is exported to SAP BW for analysis.

### 4.3.5 Transportation and Logistics Collaboration Portal Analysis Tools

#### 4.3.5.1 Back-End Error Messages

Back-end error messages are saved in the Netweaver Gateway system. To access these error messages, perform the following steps:

1. Run transaction /IWFND/ERROR_LOG
2. Select the log entry, and choose Error Context
3. Choose Application Log
   - Note down the error number of each message with the message text: This is an external message. Access message text via details
4. To view the text of each external error message, choose Detail Exists

#### 4.3.5.2 Front-End Error Messages

Front-end error messages are displayed in the message bar at the bottom of the screen. There can be instances in which no front-end error messages are displayed but the application is not responding as expected. In these
instances, the browser console can contain the error messages. To access these messages on the browser, perform the following steps:

1. Open the developer tools of the browser
2. Go to the Console tab page

To access these messages on the Apple iPad, perform the following steps:

1. Connect the Apple iPad to an Apple MacBook
2. Activate the Web Inspector on the iOS operating system
3. Open the Safari browser and connect to the Apple iPad
4. Go to Console tab page

For more information about accessing messages on the Apple iPad, see http://developer.apple.com/library/safari/#documentation/appleapplications/reference/safariwebcontent/DebuggingSafariiPhoneContent/DebuggingSafariiPhoneContent.html#/apple_ref/doc/uid/TP40006515-SW1

4.3.5.3 Cache Clean-Up

Caches are used in the portal to achieve reasonable performance. These caches include the browser cache and the UI source code cache. When you change the source code due to modifications, implementation of notes or updates, we recommend that you clean up the caches.

To clean the UI source code cache, perform the following steps:

1. In the browser, enter &lt;Portal URL&gt;/resetcachebuster
2. Enter user and password
   If the cache is cleaned, the system displays the message: Cachebuster for SAPUI5 application "/tmui/coll_portal" has been reset

To clean the browser cache, perform the following steps:

- **Microsoft Internet Explorer**
  Go to Settings &gt; Developer Tools (F12) &gt; Cache
  Choose Clear Browser Cache.
- **Google Chrome**
  Go to Menu &gt; Tools &gt; Clear Browsing Data
  Select Empty the cache and choose Clear Browsing Data.
- **Mozilla Firefox**
  Go to Options &gt; Advanced &gt; Network &gt; Cached Web Content
  Choose Clear Now.
- **Safari on Apple Ipad**
  Go to Settings &gt; Safari
  Choose Clear Cookies and Data.
4.4 Data Consistency

If you store related or identical data in multiple places, inconsistencies may occur (for example, after you restore a single component). The following information describes how you can verify consistency and resolve inconsistencies.

SAP TM 9.5 uses standard tools available in SAP Web Application Server 7.5, and does not require an application-specific tool.


SAP TM exchanges data with SAP ERP using asynchronous messages. If such a message exchange fails, you can re-send messages. Cases of data inconsistency do not, therefore, apply here. For more information about tools for checking message exchange errors, see Monitoring of SAP Transportation Management [page 11].

Internal Data Consistency

Internal data consistency describes the correctness of master data and transactional data that you create, change, or delete in the SAP TM application.

Master Data

Master data for SAP TM is located in different software layers, for example SAP TM and SCM Basis. When the system processes master data objects in transactions or automated functions, it ensures consistency by using standard checking procedures. Transactions can identify inconsistent master data objects, and the system displays error messages on-screen and in the application log. You must create an error message for SAP support to check and resolve these errors. A system breakdown does not create master data inconsistencies because the system can only commit consistent data.

Transactional Data

Transactional data for SAP TM is located in the SAP TM software layer. The same rules apply for transactional data consistency as for master data.

Available Tools

No tools specific to SAP TM are required to check data consistency.

External Data Consistency

Implementing an SAP TM system in your system landscape increases the demand on your interface management and system administration by increasing data exchange between systems. In particular, you create a close connection between the SAP ERP systems and SAP TM. Correct, consistent, and current data is a prerequisite for successful planning activities in SAP TM.

Causes of External Data Inconsistency

You can have data inconsistency between systems if one or more of the following events occur:

- Incomplete recovery in one of the systems in the system group
- Manual change of data in SAP ERP or SAP TM
- Program errors
- Incorrect intervention in the core interface (CIF), for example, if you delete orders without transferring them to SAP TM
We provide standard tools for checking internal and external consistency. How you use these tools depends on the scenario you implement in SAP TM. We recommend that you run CIF post processing after you complete internal consistency checks and before you start external consistency checks. If more than one SAP ERP system is connected to an SAP TM system, you must use the corresponding tool for each of these SAP ERP systems and the SAP TM system.

**SAP Transportation Management – SAP Optimizer**

Since the SAP Optimizer is a stateless engine, we do not expect you to encounter any data inconsistencies between SAP TM and the SAP Optimizer. If the SAP Optimizer crashes during a planning run, SAP TM does not receive optimization results and therefore cannot save inconsistent data.

We also do not expect inconsistent business documents to occur for packaged processing. It may happen that you can commit a certain data package successfully, while the next commit fails. This creates a number of successfully planned business documents and a number of unprocessed business documents. You can start the required business transaction for the unprocessed documents again.

SAP TM informs you if the SAP Optimizer is not available when you start a planning run. We recommend that you monitor the availability of the SAP Optimizer closely. You can restart failed optimization runs when the SAP Optimizer is running again.

For more details, see the Application Operations Guide for the SAP Optimizer.

**SAP Transportation Management – OLTP**

In a system setup that includes SAP TM and an online transaction processing (OLTP) system such as SAP ERP, it is important to ensure data consistency between the systems. Due to the close link between the systems and the business impact of a system breakdown, we recommend that you closely monitor the inbound and outbound queues, system availability, and application logs of all the systems involved so that you can react quickly.

If you have a system breakdown, none of the systems internally commits inconsistent data. If such an error occurs, you must create a message for SAP support. To quickly restore data consistency on both sides, you must resend any missing business documents after you restart the unavailable components.

**Consistency Check Procedure**

The following consistency check procedure applies to all SAP TM releases:

1. **Lock the users**
   
   You need to do this in case you need to perform a consistency check and the SAP TM system does not allow any active processes. Lock all users except for the administrator, until you restore data consistency.

2. **Check and end system activities**

   Users who are already logged on must leave the system, and you must stop scheduled background jobs for the duration of the consistency check. You can send messages to the relevant users. You must terminate active tasks and jobs, or you must wait until they have finished.

3. **Lock CIF queues**

   Depending on the object you need to check, you may also need to stop CIF queues so that data transfers are not made from the OLTP systems for the duration of the consistency check. If you are using inbound queues, you can stop the transfer by using report RSTRFCI1. If you are using outbound queues, you must use transaction SMQ1 and program RSTRFCQ1 in the relevant OLTP systems to stop the transfer.

4. **Select the objects to be checked and the scope of the check**

   You must identify the business documents that are affected by the system breakdown in the application log or CIF queues.

5. **Execute the consistency check**

6. **Correct inconsistencies**
You use the tools provided to correct data inconsistencies. Alternatively, you can create a message for SAP support.

7. Unlock the CIF queues
   After the consistency checks, or when you have restored internal data consistency, you can restart the CIF queues. If you are using inbound queues, use report **RSTRFCQ3**. If you are using outbound queues, you must restart the queues using transaction **SMQ1** and program **RSTRFCQ3**.

8. Release the background jobs that you stopped earlier

**Known Problems**

A heavy data load at the interface can cause the system to report inconsistencies that do not actually exist. This is because the system cannot post the data that is being transferred fast enough.

In this case, you cannot correct an inconsistency by transferring the data again.

Use the queued remote function call (qRFC) monitor to check the relevant entry in the queue. Use the error number specified to find a relevant SAP Note. If this procedure and the debugging of the relevant queue do not produce any results, create a message for SAP support. Provide details about the queue name and all the relevant logon data from your system.

**OLTP and OLAP Systems**

An OLTP system covers functions for sales and distribution, material and inventory management, controlling, shop floor control, logistic execution, and so on.

An online analysis processing (OLAP) system provides accumulated historical data as a basis for analysis in SAP TM. An example of such a system is SAP Business Information Warehouse (BW).
5  Management of SAP Technology

5.1  Introduction

We provide you with an infrastructure to help your technical support consultants and system administrators effectively manage all SAP components and complete all tasks related to technical administration and operation.

For more information about the underlying technology, see the Technical Operations Manual in SAP Library under SAP NetWeaver.

5.2  Starting and Stopping

For the list of components required for each scenario, see Scenario/Component Matrix [page 8].

If a component does not start properly, see Troubleshooting [page 40] to analyze the problem.

Start and Stop Sequences and Tools

We recommend that you start the components in the following order. To stop, proceed in the reverse order.

Table 9: Start and Stop Sequences and Tools

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Start and Stop Sequences and Tools</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Transportation Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TM Server</td>
<td>1  STARTSAP / STOPSAP (Unix)</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J2EE Engine</td>
<td>2  Depending on the system landscape</td>
<td>Required for Adobe Document Services</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP ERP 6.0</td>
<td>3  STARTSAP / STOPSAP (Unix)</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver BI 7.0 Server</td>
<td>4  STARTSAP / STOPSAP (Unix)</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Software Component

<table>
<thead>
<tr>
<th>Software Component</th>
<th>Start and Stop Sequences and Tools</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP Transportation Management</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Exchange</td>
<td>5</td>
<td>STARTSAP / STOPSAP (Unix)</td>
</tr>
<tr>
<td>Infrastructure (XI) Server</td>
<td></td>
<td>SAPMM (Windows)</td>
</tr>
<tr>
<td>CIF (Plug-In)</td>
<td>6</td>
<td>Not applicable</td>
</tr>
<tr>
<td>In SAP TM, CIF is only used if SAP ERP is used and the relevant master data is transferred from SAP ERP to SAP TM. It is not used to transfer transactional data from SAP ERP to SAP TM and vice versa.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP SCM Optimizer</td>
<td>7</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Internet Graphics Server (IGS)</td>
<td>8</td>
<td>You can start/stop the Windows IGS by using services. Choose Start Settings Control Panel (or: Administrative Tools) Services SAP IGS (scroll down) Button: Start/Stop Service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

Even though SAP XI and SAP SCM Optimizer can be started independently of all other components, we recommend that you start and stop the components in a certain sequence.


### Starting and Stopping CIF

- To **start** the CIF queues of your SAP TM system, use the following reports in SAP TM and all connected ERP systems.
  - For outbound queues, use report RSTRFCQ3.
    - Enter the following values:
      - Parameter QNAME: **CF**
      - Parameter DEST: `<Name of logical system>`
      - Parameter FORCE: no entry required
      - Parameter NO_ACT: no entry required
For inbound queues, use report RSTRFCI3. Enter the following values:

- Parameter QNAME: CF*
- Parameter FORCE: no entry required
- Parameter MAXLUW: no entry required
- Parameter NO_ACT: no entry required

To determine whether you are using inbound or outbound queues, call transaction CFC1 in the connected SAP ERP systems and transaction /SAPAPO/C2 in the SAP TM system.

If you are using outbound queues, you only need to start the outbound queues. If you are using inbound queues, inbound and outbound queues have to be started.

To stop the queues, use the following reports in the SAP TM system and all connected SAP ERP systems according to the queue type you are using:

For outbound queues, use report RSTRFCQ1. Enter the following values:

- Parameter QNAME: CF*
- Parameter DEST: <Name of Logical System of receiving system>
- Parameter FORCE: no entry required

For inbound queues, use report RSTRFCI1. For parameter QNAME, enter CF*. No entry is required for parameter FORCE.

To determine whether you are using inbound or outbound queues, call transaction CFC1 in the connected SAP ERP systems and transaction /SAPAPO/C2 in the SAP TM system.

If you are using outbound queues, you only need to stop the outbound queues. If you are using inbound queues, inbound and outbound queues have to be stopped.

For more information, see SAP Note 505304.

### Starting and Stopping the J2EE Engine

If you want to print from SAP Transportation Management, you have to be able to start/stop the J2EE Engine. Different procedures apply depending on your operating system and how you installed the J2EE Engine in your system landscape.

For detailed documentation about starting and stopping the J2EE Engine, see the Technical Operations Manual for the J2EE Engine.

The Technical Operations Manual for the J2EE Engine is part of the Technical Operations Manual for SAP NetWeaver and can be found in SAP Library.

### 5.3 Software Configuration

This section explains which components or scenarios used by this application can be configured and which tools are available for making adjustments. To avoid dumps caused by lack of available memory, enter 250MB as the value for parameter abap/shared_objects_size_MB. For more information, see SAP note 1780851.
Table 10: Component Configuration Tools

<table>
<thead>
<tr>
<th>Component</th>
<th>Configuration Tool(s)</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP SCM Basis</td>
<td>Not relevant</td>
<td>No technical configuration data</td>
</tr>
<tr>
<td>SAP TM</td>
<td>Not relevant</td>
<td>No technical configuration (all technical configuration that is required for running SAP TM is part of SAP NetWeaver)</td>
</tr>
</tbody>
</table>

5.4 Administration Tools

5.4.1 Introduction

All SAP TM 9.5 components are technically based on SAP NetWeaver.


5.4.2 Administration Tools for SAP Transportation Management 9.5

The following tools can be used for administration of the SAP TM 9.5 system:

Table 11: Administration Tools for SAP TM

<table>
<thead>
<tr>
<th>Monitoring Object</th>
<th>Monitoring Transaction / Tool</th>
<th>Monitor Frequency</th>
<th>Monitoring Activity or Error Handling Procedure</th>
<th>Responsible</th>
<th>Escalation Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluation of Application Log</td>
<td>Transaction SLG1</td>
<td>Daily</td>
<td>Evaluate the application log in SAP Transportation Management</td>
<td>Program scheduling management</td>
<td>Contact application support</td>
</tr>
</tbody>
</table>

For more information about the administration tools for SAP TM 9.5, see SAP Transportation Management 9.4 Analysis Tools [page 13].

5.4.3 Administration Tools for SAP SCM Optimizer

The following tools can be used for administration of the SAP SCM Optimizer system.
### Transport of Configuration Settings

All configuration settings of SAP SCM Optimizer are stored on the application server. Standard ABAP transports and Customizing settings can, therefore, be used to transport configuration settings.

### Customer Modifications

The different optimizers cannot be changed by the customer. If customer-specific changes have been approved by SAP, they are incorporated into the standard optimizer engines. Therefore, no special version management is required. For changes outside SAP SCM Optimizer (ABAP), the Workbench can be used.

Conflicts between customer-specific changes (ABAP) and SAP updates can be solved using the Workbench.

### 5.4.4 Administration Tools for SAP Business Information Warehouse

**Table 13:**

<table>
<thead>
<tr>
<th>Transaction/Tool</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMQ1</td>
<td>Use this transaction to monitor whether the delta data is filled into the outbound queue.</td>
</tr>
<tr>
<td>SMQR</td>
<td>Use this transaction to check the status of the scheduler, and to stop or start it.</td>
</tr>
</tbody>
</table>
5.5 Backup and Restore

5.5.1 Introduction

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of failure.

The backup and restore strategy for the application consists of two parts:

- Backup and restore coverage for each component
- Cross-system data dependencies and handling

The backup and restore strategy for your system landscape should not only consider SAP systems but should also be embedded in the overall business requirements and incorporate your company’s entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data center through fire. It is most important in this context that you ensure that backup devices are not lost together with normal data storage (separation of storage locations).

Table 14:

<table>
<thead>
<tr>
<th>Component</th>
<th>Category</th>
<th>Application Data Type</th>
<th>Backup Method for Application Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP TM Server</td>
<td>XI</td>
<td>Original and Replicated</td>
<td>Database and log backup</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>File system backup (full or incremental)</td>
</tr>
<tr>
<td>SAP SCM Optimizer</td>
<td>II</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>SAP IGS</td>
<td>II</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>SAP XI Server</td>
<td>XI</td>
<td>Original and Replicated</td>
<td>Database and log backup</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>File system backup (full or incremental)</td>
</tr>
</tbody>
</table>
5.5.2 SAP TM Server / SAP SCM Optimizer

The SAP TM Server is a component that receives data from other systems, such as SAP ERP, and is also the leading system for some application data of its own. The SAP TM system is based on SAP Web Application Server.

In an SAP TM scenario, dependencies may exist to multiple other components such as SAP ERP, which are based on SAP Web Application Server as well.

In the case of a complete restore of the SAP TM database without data loss, there is no impact on external data consistency with other systems. If data loss occurs, see section 5 (Managing Incomplete Recovery) of the best-practice document Backup and Restore for SAP Business Suite. This document is available on SAP Service Marketplace at http://service.sap.com/aim-methodologies/Best-Practice Documents/Backup and Restore for SAP System Landscapes.

For more information about backup, restore, and recovery of the SAP TM Server and SAP SCM Optimizer including online backup and back up of the scenarios, also see the best-practice document Backup and Restore for SAP Business Suite.

5.5.3 SAP Internet Graphics Server

Classification

The SAP IGS does not contain any persistent application data. Therefore, you only need to back up the IGS itself and the configuration files.

Backup

Depending on where the IGS is installed, you have the following options for backup and recovery:

1) Installation on Web AS

If you have installed the IGS on the Web Application Server, you have two options for backup and recovery:

1. Make a backup of all files of the IGS installation using operating system tools. You can recover the IGS by using your backup.
2. Make a backup of all files in the conf directory of the IGS installation. For a recovery, reinstall the IGS and copy all files from the back-up conf directory to the conf directory.

2) Standalone Installation on Microsoft Windows Server

If you have installed the IGS on a standalone Microsoft Windows server, you have two options for backup and recovery:

1. Make a backup of all files of the IGS installation. For a recovery, restore the IGS files and restart the IGS service in Microsoft Windows using command igswdserv -i in the bin directory of the installation directory.
2. Make a backup of all files in the directory conf of the IGS installation. For a recovery, reinstall the IGS and copy all files from the back-up conf directory to the conf directory.
5.5.4 SAP XI Server

For the backup and recovery concept for all other SAP NetWeaver components mentioned in this guide, including the SAP Exchange Infrastructure (XI) Server, see the Technical Operations Manual for SAP NetWeaver in SAP Library.

5.6 Periodic Tasks

5.6.1 Introduction

In addition to the standard jobs mentioned in the Technical Operations Manual for SAP NetWeaver (in SAP Library under SAP NetWeaver), you must schedule SAP TM-specific jobs in your SAP system. All jobs, unless otherwise specified, should be run at times of minimal system activity, so as not to affect performance or otherwise disrupt your daily operations. All jobs can be restarted. There are no dependencies between the jobs.

5.6.2 Scheduled Periodic Tasks

This section describes all tasks that can be automated and that are required to run periodically to keep the application running smoothly. Such tasks may be required on component level and are, therefore, relevant in each scenario that uses the component. You can find the mapping in the Scenario/Component Matrix [page 8] section. Other tasks may be relevant for certain business scenarios only. It is important that you monitor the successful execution of these tasks on a regular basis.

Table 15:

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Standard / Housekeeping Jobs for SAP Transportation Management

<table>
<thead>
<tr>
<th>Report</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>POWL_WLOAD</strong></td>
<td>Once, nightly</td>
<td>All user query (work lists) results within a POWL context are cached into an internal cluster table. Every time a user chooses the refresh link in the worklist, the results of the feeder class method GET_OBJECTS are saved to this cache. The POWL always reads the cache regardless of the Sync setting in the type repository or query definition. This cache enables the administrator to create a scheduled worklist using the POWL_WLOAD report.</td>
</tr>
<tr>
<td><strong>SBAL_DELETE</strong></td>
<td>Occasionally, for example, monthly</td>
<td>As described in SAP Note 195157, using the application log occupies storage space on the database. To free the database of outdated entries, we recommend that you execute report SBAL_DELETE periodically. Recommendation: coordinate with archiving cycles.</td>
</tr>
<tr>
<td><strong>SAPA_DELETE_PRODUCTS</strong></td>
<td>Monthly</td>
<td>Master data: Deletes products with deletion flag</td>
</tr>
<tr>
<td><strong>SAPA_DELETE_LOCATIONS</strong></td>
<td>Yearly</td>
<td>Master data: Deletes locations with deletion flag</td>
</tr>
<tr>
<td><strong>SCMB/ALEN_ALERT_DELETE</strong></td>
<td>Weekly/monthly</td>
<td>Deletes alerts older than x days</td>
</tr>
<tr>
<td><strong>SCMTMS/PLN_EXP_DELETE</strong></td>
<td>Daily</td>
<td>Deletes Optimizer Explanation logs older than x days</td>
</tr>
</tbody>
</table>

### Table 16:

#### Standard / Housekeeping Jobs for TM Tendering

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SCMTMS/TEND_CONT_PROCESS</strong></td>
<td>Every 5 to 120 minutes, depending on the minimum response times for carriers in tendering</td>
<td>Processes incoming freight quotations and continues the tendering process after a freight quotation has been received or after the maximum response time for a freight request for quotation is over.</td>
</tr>
</tbody>
</table>
### Standard / Housekeeping Jobs for TM Tendering

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report /SCMTMS/TEND_PROCESS_INBOX</td>
<td>Same frequency as report /SCMTMS/TEND_CONT_PROCESS. We recommend that you run this report immediately before /SCMTMS/TEND_CONT_PROCESS.</td>
<td>Converts freight quotations that have been received from carriers by e-mail so that the quotations can be processed by report /SCMTMS/TEND_CONT_PROCESS. This report is not required if receiving freight quotations by e-mail is not enabled.</td>
</tr>
<tr>
<td>Report /SCMTMS/TEND_NOTIFICATION_MAIL</td>
<td>Hourly/daily</td>
<td>Instead of notifying a carrier immediately about tendering events by e-mail, the system administrator can choose to send collective e-mails to carriers periodically. Schedule this report to create these notification e-mails.</td>
</tr>
</tbody>
</table>

### Table 17:

### Standard / Housekeeping Jobs for SAP SCM Optimizer

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report RCC_CLEANUP Transaction RCC_CUST</td>
<td>Daily</td>
<td>This report should be run daily to delete all log entries made by RCC and all external files on remote engine servers for which the log deletion time parameter is set in rcc_cust.</td>
</tr>
<tr>
<td>Report BRCONNECT</td>
<td>Daily</td>
<td>Calculates BI-relevant optimizer statistics (for Oracle); see SAP Notes 129252 and 421795.</td>
</tr>
</tbody>
</table>

### Table 18:

### Standard / Housekeeping Jobs for SAP TM Collaboration Portal

<table>
<thead>
<tr>
<th>Program Name/Task</th>
<th>Recommended Frequency</th>
<th>Detailed Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report /SCMTMS/UPLOAD_RFQ_RESPONSE</td>
<td>Daily</td>
<td>This report should be scheduled daily in order to import carrier responses uploaded through the collaboration portal.</td>
</tr>
</tbody>
</table>
5.6.3 Required Manual Periodic Tasks

This section describes all manual tasks that must be run periodically to keep the application running smoothly. A manual task must be executed by a user, whereas the scheduled tasks listed above can be automated using a task scheduler program. Such tasks may be required on component level and are, therefore, relevant in each scenario that uses the component. You can find the mapping in the Scenario/Component Matrix section. Other tasks may be relevant for certain business scenarios only. It is important that you monitor the successful execution of these tasks on a regular basis.

5.7 Load Balancing

SAP TM 9.5 uses standard functions for logon and load balancing available in SAP Web Application Server 7.5, and does not require an application-specific tool. For more information, see the Technical Operations Manual for SAP NetWeaver.


5.8 Trigger Processing

SAP Transportation Management (SAP TM) uses bgRFC (Background Remote Function Call) technology to reliably process asynchronous updates. To use this technology, you need to create a bgRFC inbound destination.
The following configuration steps are required for creating an inbound destination in the SAP TM system:

1. Go to transaction SBGRFCCONF.
2. Go to the Define Inbound Dest. tab page and choose Create.
3. In the Inb. Dest. Name field, enter TM_BGRFC_INBOUND.
4. Choose Save to save the queue prefixes.
5. In the bgRFC Configuration screen, choose Save to save your Customizing settings.

### 5.9 Management of Outdated Technical Data

#### Application Copy

For a **homogeneous** system copy of all the components for SAP Transportation Management, the standard procedures of SAP NetWeaver apply.

For more information, see the System Copy documentation in Technical Operations Manual for SAP NetWeaver in SAP Library.

**Heterogeneous** system copies are currently supported on request and on a project basis. For more details and forms, see [http://service.sap.com/osdbmigration](http://service.sap.com/osdbmigration).

---

**Note**

A client copy from one system to another with a different operating system or database is not an alternative to a complete heterogeneous migration. For example, client copies do not ensure that all repository changes are transferred to the new system. Therefore, if you want to change your database or application server platform, a heterogeneous system copy is the only procedure that ensures full data replication into the new system.

### 5.10 Scenario Administration Concept

#### User Management

SAP TM 9.5 uses standard functions for user management available in SAP Web Application Server 7.5 and does not require an application-specific tool. For more information, see the Technical Operations Manual for SAP NetWeaver.

For more information about user management in SAP TM, see also the SAP TM Security Guide.

#### Printing

SAP Transportation Management uses standard functions of SAP NetWeaver for printing and does not require an application-specific tool. For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at [http://](http://)

Quality Management and Test Management

You can use the SAP NetWeaver Development Infrastructure to learn about the various possibilities to test your software changes.
6 High Availability

6.1 Introduction


For more information, see http://scn.sap.com/community/business-continuity.

6.2 SAP SCM Optimizer

High availability of SAP SCM Optimizer can be achieved by installing the optimizer programs on several servers. Optimizer runs can be distributed to several machines during normal productive use to provide load balancing.

The high availability concept cannot restore the actual state of an aborted optimizer run – the optimizer run has to be repeated completely – but it can ensure immediate availability of the optimizer software on a backup location.

For more information, see the SAP SCM Optimizer Installation Guide, which is available on SAP Service Marketplace at https://service.sap.com/instguides > SAP Business Suite Applications > SAP Transportation Management > SAP SCM Optimizer.

Note

There is no need to use cluster software.
7 Software Change Management

7.1 Introduction

Software Change Management standardizes and automates software distribution, maintenance, and testing procedures for complex software landscapes and multiple software development platforms. These functions support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that allows for specific maintenance procedures, global rollouts (including localizations), and open integration with third-party products.

This section provides additional information about the most important software components for SAP Transportation Management.

The following topics are covered:

- Transport and Change Management – Enable and secure the distribution of software changes from the development environment to the quality assurance and production environment.
- Template Management – Enables and secures the rollout of global templates, including localizations.
- Quality Management and Test Management – Reduce the time, cost, and risk associated with software changes.
- Support Packages and SAP Notes Implementation – Provide standardized software distribution and maintenance procedures.
- Release and Upgrade Management – Reduces the time, cost, and risk associated with upgrades.

7.2 Transport and Change Management

SAP TM 9.5 uses standard functions for transport and change management issues in SAP Web Application Server 7.5 and does not require application-specific tools or procedures.

7.3 Development Requests and Development Release Management

SAP TM 9.5 uses standard functions for development request and development release management issues in SAP Web Application Server 7.5 and does not require application-specific tools or procedures.


7.4 Template Management

You can configure Customizing settings by using Business Configuration Sets (BC sets). For more information about BC sets, see SAP Library under Business Configuration Sets (BC-CUS).

7.5 Support Packages and Patch Implementation

SAP TM 9.5 uses standard functions for software maintenance in SAP Web Application Server 7.5 and does not require application-specific tools or procedures.


For more information about the implementation of Support Packages as well as possible side effects, see http://service.sap.com/patches ➤ SAP Support Packages in Detail.

SAP TM 9.5 Recommendations

We recommend implementing Support Package Stacks (SP Stacks), which are sets of Support Packages and patches for the respective product version that must be used in the given combination. The technology for applying Support Packages and patches will not change.

For more information about the availability of SP Stacks for SAP TM 9.5, see SAP Service Marketplace at http://service.sap.com/sp-stacks.

Read the corresponding Release and Information Notes (RIN) before you apply any Support Packages or Patches of the selected SP Stack.
The RIN and Support Packages for SAP TM 9.5 are available on SAP Service Marketplace at http://service.sap.com/patches. Use the search function to find the maintenance product for SAP TM 9.5.
8 Services for SAP Solutions

For an overview of all services and support provided by SAP, see SAP Service Marketplace at http://service.sap.com/servicesmap.
9 Troubleshooting

SAP TM 9.5 uses standard functions for troubleshooting in SAP Web Application Server 7.5 and does not require application-specific tools or procedures. For more information, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw75. In SAP Library for SAP NetWeaver 7.5, choose SAP NetWeaver Administration Information ➤ Technical Operations for SAP NetWeaver ➤ Administration of Application Server ABAP ➤ Monitoring and Administration Tools for Application Server ABAP.

In addition, see the troubleshooting notes section in this document.
10 Support Desk Management

10.1 Introduction

Support Desk Management enables you to set up an efficient internal support desk for your support organization that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to run your internal support organization efficiently.

10.2 Remote Support Setup

For information about remote support setup, see SAP Service Marketplace at http://service.sap.com/access-support.

The read-only support role for SAP TM 9.5 is /SCMTMS/DISPLAY.

10.3 Problem Message Handover

For information about processing internal support messages and forwarding them to SAP, see SAP Library for SAP Solution Manager on SAP Help Portal at http://help.sap.com/solutionmanager. In SAP Library for SAP Solution Manager 7.0, choose SAP Solution Manager ➤ Incident Management ➤ Service Desk.

For sending problem messages/tickets to SAP, choose the appropriate component (or subcomponent) name from the SAP component hierarchy.

The correct component for SAP TM 9.5 related messages is TM*.

For information about safeguarding, see http://service.sap.com/safeguarding.
## A.1 Categories of System Components for Backup and Restore

### Table 19:

<table>
<thead>
<tr>
<th>Categories of System Components</th>
<th>Category Properties</th>
<th>Suggested Methods for Backup and Restore</th>
<th>Examples</th>
</tr>
</thead>
</table>
| I                               | Only software, no configuration or application data | • No backup, new installation in case of a recovery  
• Initial software backup after installation and upgrade  
• Backup of log files | BDOC modeler |
| II                              | Only software and configuration information; no application data | • Backup after changes have been applied  
• No backup, new installation in case of a recovery  
• Backup of log files | SAP Gateway Comm. Station  
SAP Business Connector  
SAP IPC (2.0C) |
| III                             | Only replicated application data; replication time is sufficiently small for a recovery | Data:  
• No data backup needed  
• Backup of software, configuration, and log files | SAP IMS/Search Engine *  
SAP IPC (2.0B) *  
Webserver *  
SAP ITS |
| IV                              | Only replicated application data; backup recommended because replication time is too long; data not managed by a DBMS | Data:  
• Application-specific file system backup  
• Multiple instances  
• Backup of software, configuration, and log files | SAP IMS/Search Engine *  
Webserver * |
| V                               | Only replicated application data; backup recommended because replication time is too long; data managed by a DBMS | Data:  
• Database and log backup  
• Multiple instances  
• Backup of software, configuration, and log files | SAP IPC (2.0B) *  
Catalog Server |
<table>
<thead>
<tr>
<th>Categories of System Components</th>
<th>Category Properties</th>
<th>Suggested Methods for Backup and Restore</th>
<th>Examples</th>
</tr>
</thead>
</table>
| VI                              | Original application data; standalone system; data not managed by a DBMS | Data:  
  - Application-specific file system backup  
  - Backup of software, configuration, and log files | Webserver * |
| VII                             | Original application data; standalone system; data managed by a DBMS; not based on SAP WebAS | Data:  
  - Database and log backup  
  - Backup of software, configuration, and log files | |
| VIII                            | Original application data; standalone system based on SAP WebAS | Data:  
  - Database and log backup, application log backup (such as job logs in file system)  
  - Backup of software, configuration, and log files | Standalone SAP ERP |
| IX                              | Original application data; data exchange with other systems; data not managed by a DBMS | Data:  
  - Application-specific file system backup, data consistency with other systems must be considered  
  - Backup of software, configuration, and log files | |
| X                               | Original application data; data exchange with other systems; data managed by a DBMS; not based on SAP WebAS | Data:  
  - Database and log backup; data consistency with other systems must be considered  
  - Backup of software, configuration, and log files | SAP liveCache  
  SAP Mobile Workbench |
### A.2 Related Guides

For more information about installation and configuration procedures, see the Master Guide for SAP TM 9.4 at http://service.sap.com/instguides.  

### A.3 Related Information

The following table contains links to information relating to the Application Operations Guide.

<table>
<thead>
<tr>
<th>Table 20:</th>
<th>Quick Link on SAP Service Marketplace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td></td>
</tr>
<tr>
<td>Related SAP Notes</td>
<td><a href="http://service.sap.com/notes">http://service.sap.com/notes</a></td>
</tr>
<tr>
<td>Released Platforms</td>
<td><a href="http://service.sap.com/platforms">http://service.sap.com/platforms</a></td>
</tr>
<tr>
<td>Network Security</td>
<td><a href="http://service.sap.com/securityguide">http://service.sap.com/securityguide</a></td>
</tr>
<tr>
<td>Technical Infrastructure</td>
<td><a href="http://service.sap.com/installNW70">http://service.sap.com/installNW70</a></td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td><a href="https://support.sap.com/en/solution-manager">https://support.sap.com/en/solution-manager</a></td>
</tr>
</tbody>
</table>
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings (“Code”) included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see: https://help.sap.com/viewer/disclaimer).